
Chapter 16

Sheet Metal Design

After completing this chapter you will be able to:
• Create Base Flange.
• Understand the FeatureManager Design Tree of a sheet metal Component.
• Create Edge Flange.
• Create Tabs.
• Create Sketched Bends.
• Create Miter Flange.
• Create Closed Corners.
• Create Hems.
• Create Jog Bend.
• Break Corners.
• Create Cuts on the Flat Faces of the sheet metal components.
• Create Loft Bends.
• Create Flat Pattern of the sheet metal component.
• Create sheet metal components from a flat sheet.
• Create sheet metal component from the flat part.
• Create sheet metal component by designing it as a part.
• Design a sheet metal part from a shelled solid model.
• Create cuts in the sheet metal component across the bends.
• Work with forming tools.
• Create cylindrical and conical sheet metal components.
• Generating the drawing views of the flat pattern of the sheet metal component.

Learning Objectives
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SHEET METAL DESIGN
In SolidWorks, you can design the sheet metal components using various tools available for
manipulating the sheet metal components in the Part mode. Generally, the solid models of
the sheet metal components are created to generate the flat pattern of the sheet, studying the
design of the dies and punches, or studying the process plan for designing the tool for
manufacturing the sheet metal components. In a tool room or in the machine shop, the most
important thing that you need before designing the press tool or bending tool or any other
tool for creating a sheet metal component is the flat pattern layout of the component. Figure
16-1 shows the model of a sheet metal component and Figure 16-2 shows the flat pattern of
this sheet metal component. As evident in Figure 16-2, a flat pattern shows the flattened view
of the sheet metal component.

Figure 16-1  Solid model of a sheet metal component

Figure 16-2  Flat pattern layout of the sheet metal component
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As discussed earlier, the sheet metal components are designed in the Part mode of SolidWorks.
To create a sheet metal component, create a new SolidWorks document in the Part mode and
then invoke the Sheet Metal toolbar. All the tools to design a sheet metal component are
available in the Sheet Metal toolbar. This toolbar is not available by default. Therefore, you
need to invoke this toolbar by choosing View > Toolbars > Sheet Metal from the menu bar.
In SolidWorks, there are five methods of creating sheet metal components. All these methods
are discussed in this chapter.

SHEET METAL DESIGN BY FIRST CREATING THE BASE
FLANGE
The first and the most widely used method of designing the sheet metal component is by first
creating the base flange. In this method, first you will create the base flange and then add the
sheet metal feature on the base flange to obtain the required sheet metal component. In this
method, you will define all the parameters related to the sheet metal such as the bending
radius, the bend allowance, and the relief while creating the base flange. The various tools
used to create the sheet metal components are discussed next.

Creating the Base Flange

For creating a sheet metal component, first you need to create a base feature or a base
sheet. This base sheet is known as base flange. You can create a base flange from a
closed sketch or an open sketch. To create a base flange, draw the sketch of the base

flange and then choose the Base-Flange/Tab button from the Sheet Metal toolbar. The Base
Flange PropertyManager is displayed as shown in Figure 16-3 and the preview of the base
flange is displayed with the default values. The various options available in the Base Flange
PropertyManager are discussed next.

Note
The parameters that you define in the Base Flange PropertyManager are taken as the default
parameters throughout the current document. However, you can modify these values using the
PropertyManager of other tools.

Direction 1
This rollout is displayed only if the sketch of the base flange is open. The options available in
the Direction 1 rollout are used to define the option for feature termination in the first
direction.

Direction 2
The options available in the Direction 2 rollout are used to define the option for feature
termination in the second direction. The Direction 2 rollout is also displayed only if the
sketch for base flange is open.

Toolbar: Sheet Metal > Base-Flange/Tab
Menu: Insert > Sheet Metal > Flange
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Figure 16-3  The Base Flange PropertyManager

Sheet Metal Parameters
The options available in the Sheet Metal Parameters rollout are used to define the thickness
and the bend radius of the sheet. The options available in this rollout are discussed next.

Thickness
The Thickness spinner available in the Sheet Metal Parameters rollout is used to define
the thickness of the sheet.

Reverse direction
The Reverse direction check box is used to flip the direction of material addition while
specifying thickness to the base flange.

Bend Radius
The Bend Radius spinner is used to specify the bend radius to the base flange. If the
sketch of the base flange is closed, the Bend Radius spinner is not available in the Sheet
Metal Parameters rollout.
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Bend Allowance
The options available in the Bend Allowance Type drop-down list of the Bend Allowance
rollout are used to specify the bend allowance to all the bends in the sheet metal component.
These options are discussed next.

Bend Table
The Bend Table option is used to specify the bending allowance using the bend tables.
When you select this option, the Bend Table drop-down list is displayed below the Bend
Allowance Type drop-down list. In SolidWorks, various bend tables are provided to
calculate the bending radius. The BASE BEND TABLE option is selected by default in
the Bend drop-down list. This is one of the default bend tables available in SolidWorks.
The other options available in this dialog box are METRIC BASE BEND TABLE,
KFACTOR BASE BEND TABLE, and SAMPLE. These all are the default bend tables
provided in SolidWorks. The Browse button available below this drop-down list is used to
browse the location of the folder if you have saved a user-defined bending table file. The
bending table file is created in Microsoft Excel.

K-Factor
The K-Factor option is used to define the K-Factor. The K-Factor is defined as the ratio of
the location of the neutral sheet to the thickness of the sheet. When you select this option,
the K-Factor spinner is displayed. Using this spinner you can specify the K-Factor.

Bend Allowance
The Bend Allowance option is used to define the bend allowance by specifying a numeric
value. When you select this option, the Bend Allowance spinner is displayed. Using this
spinner, you can specify the bend allowance.

Bend Deduction
The Bend Deduction option is used to define the bend deduction. When you select this
option, the Bend Deduction spinner is displayed. Using this spinner, you can specify the
bend deduction.

Auto Relief
The Auto Relief rollout is used to define the automatic relief in the sheet metal component.
The reliefs are provided in the sheet metal component to avoid tearing of the sheet while
bending. The options available in this rollout are discussed next. Note that you will learn
about types of reliefs in detail later in this chapter.

Auto Relief Type
The Auto Relief Type rollout is used to define the type of relief that you need to specify
to the base flange. The types of reliefs available in this drop-down list are Rectangle,
Tear, and Obround. If you select the Rectangle and the Obround type of relief, the
Relief Ratio spinner is displayed to define the relief ratio.

Figure 16-4 shows an open sketch with a single sketched entity and Figure 16-5 shows the
resultant base flange. Figure 16-6 shows an open sketch will multiple sketch entities and
Figure 16-7 shows the resultant base flange with the bending radius applied automatically to
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Figure 16-4  Open sketch with a single entity Figure 16-5  Resultant base flange

Figure 16-6  Open sketch with multiple entities Figure 16-7  Resultant base flange

Figure 16-8  Closed sketched Figure 16-9  Resultant base flange

the edges. Figure 16-8 shows the closed sketch and Figure 16-9 shows the resultant base
flange.
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Understanding the FeatureManager Design Tree of a Sheet
Metal Component
After creating the base flange, you will notice that there are some elements displayed in the
FeatureManager Design Tree. Figure 16-10 shows the various elements displayed in the
FeatureManager Design Tree after creating the base flange. All these elements are discussed
next.

Sheet-Metal1 Feature
The Sheet-Metal1 feature contains all the information about the default sheet metal parameters
such as bend parameters, bend allowance, and auto relief. The values assigned to these
parameters are automatically applied to all the other sheet metal features that you add to the
base flange. At any stage of the design, you can edit these parameters by selecting Sheet-Metal1
and invoking the shortcut menu. Choose Edit Definition from the shortcut menu. The
Sheet-Metal1 PropertyManager is displayed. Using this, you can modify the default sheet
metal parameters.

Base-Flange1 Feature
The Base-Flange1 feature is displayed after creating the base flange. Using this, you can edit
the thickness of the sheet, bend radius and the feature termination options. You can also edit
the sketch of the base flange using this feature.

Flat-Pattern1 Feature
The Flat-Pattern1 feature is also available after creating the base flange. This feature is used
to create the flat pattern of the bended sheet metal component. By default, this feature is
suppressed. You will learn more about flat patterns later in this chapter.

Figure 16-10  Various elements of the FeatureManager Design
Tree after creating the base flange
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Creating the Edge Flange

Edge flange is a bended sheet metal wall created at an angle to an existing edge of the
base flange or an existing flange. To create an edge flange, choose the Edge Flange
button from the Sheet Metal toolbar. The Edge-Flange PropertyManager is invoked

and you are prompted to select a linear edge of a planar face to create the edge flange. The
Edge-Flange PropertyManager is displayed in Figure 16-11.

Next, you need to select the edge along which the flange will be created as shown in
Figure 16-12. As soon as you select the edge, the preview of the edge flange with the drag
handle will be displayed in the drawing area as shown in Figure 16-13. The length of the
resultant flange will dynamically change as you move the cursor.

Toolbar: Sheet Metal > Edge Flange
Menu: Insert > Sheet Metal > Edge Flange

Figure 16-11  The Edge-Flange PropertyManager
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Figure 16-12  Edge selected to add edge flange

Figure 16-13  Preview of the edge flange with the drag handle

The options available in the Edge-Flange PropertyManager are discussed next.

Flange Parameters
The Flange Parameters rollout is used to define the edge reference to be used for creating
the edge flange, the bending radius, and the profile of the edge flange. These options are
discussed next.

Edge
The Edge display area is used to display the name of the edge selected to create the edge
flange.

c16-solidworks-2003.p65 7/23/2003, 12:18 PM9
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Edit Flange Profile
The Edit Flange Profile button is chosen to edit the profile of the edge flange. By default,
the edge flange is created across the entire length of the selected edge. To edit the profile
of the edge flange, choose the Edit Flange Profile button. The Profile Sketch dialog box
is displayed, that informs you that the sketch is valid and the sketching environment is
also invoked. Using the sketching tools, edit the sketch of the profile of the edge flange.
You will also notice that while editing the sketch of the edge flange, the Profile Sketch
dialog box informs you whether the sketch is valid for creating the edge flange or not.
When the status of the sketch is shown valid in the Profile Sketch dialog box, the preview
of the flange is also displayed in the drawing area. After editing the profile, choose the
Finish button from the Profile Sketch dialog box. The resultant flange will be created
and the Edge-Flange PropertyManager will be automatically closed. Note that if you
want to modify the other parameters of the flange, choose the Back button from the
Profile Sketch dialog box. Figure 16-14 shows the edge flange created by selecting the
edge. Figure 16-15 shows the edited sketch of the edge flange and Figure 16-16 shows the
resultant edge flange.

Figure 16-14  Edge flange created by selecting the edge

Figure 16-15  Edited sketch of the edge flange Figure 16-16  Resultant edge flange
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Angle
The Angle rollout is used to define the angle of the flange. The default angle of the flange is
90-degree. You can define any other angle of the flange using the Flange Angle spinner
provided in this rollout. You can create an edge flange having an angle greater than 0-degree
and less than 180-degree. Figure 16-17 shows an edge flange created at an angle of 45-degree.
Figure 16-18 shows an edge flange created at an angle of 135-degree.

Flange Length
The Flange Length rollout is used to define the length of the flange. In other words, the
options of feature termination are available in this rollout. The feature termination options
are the same as discussed earlier. The other two options provided in this rollout are discussed
next.

Outer Virtual Sharp
The Outer Virtual Sharp button is used to define the length of the flange from the outer
virtual sharp. The outer virtual sharp is an imaginary vertex created by virtually extending
tangent lines from the outer radius of the bend. Figure 16-19 shows the outer virtual
sharp.

Inner Virtual Sharp
The Inner Virtual Sharp button is selected by default and is used to define the length of
the flange from the inner virtual sharp. The inner virtual sharp is an imaginary vertex
created by virtually extending tangent lines from the inner radius of the bend. Figure 16-19
shows the inner virtual sharp.

Figure 16-17  Edge flange created at an angle
of 45-degree

Figure 16-18  Edge flange created at an angle
of 135-degree

Tip. After creating the edge flange you can also edit the sketch of the edge flange.
To edit the sketch of the edge flange, select the edge flange feature from the
FeatureManager Design Tree and invoke the shortcut menu. Choose the Edit
Sketch option from the shortcut menu. The sketcher environment is invoked, edit
the sketch and then exit the sketcher environment.
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Figure 16-19  Outer Virtual Sharp and Inner Virtual Sharp

Flange Position
The Flange Position rollout is used to define the position of the flange that you need to
create in reference to the edge. The options available in this rollout are discussed next.

Material Inside
The Material Inside button is used to create the edge flange with the material of the
edge flange inside the maximum limit of sheet. Figure 16-20 shows the edge flange created
with the Material Inside button selected.

Material Outside
The Material Outside button is chosen by default and it creates the edge flange outside
the maximum limit of the sheet. Figure 16-21 shows the edge flange created with the
Material Outside button chosen.

Figure 16-20  Edge flange created with the
Material Inside button chosen

Figure 16-21  Edge flange created with the
Material Outside button chosen
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Figure 16-22  Edge flange created with the Bend
Outside button chosen

Figure 16-23  Edge flange created with the
Bend from Virtual Sharp button selected

Bend Outside
The Bend Outside button is used to create an edge flange with the bending of the sheet
starting from outside the maximum limit of the sheet as shown in Figure 16-22.

Bend from Virtual Sharp
The Bend from Virtual Sharp button is used to create an edge flange with the bending of
the sheet starting from the virtual sharp. This value depends on whether you select the
Outer Virtual Sharp button or Inner Virtual Sharp button from the Flange Length
rollout. Figure 16-23 shows the edge flange created with the Inner Virtual Sharp and
Bend from Virtual Sharp buttons chosen.

Trim side bends
The Trim side bends check box is used to trim extra materials in the bends surrounding
the current edge flange. By default, this check box is not selected. Figure 16-24 shows the
edge flange created with the Trim side bends check box cleared. Figure 16-25 shows the
edge flange created with the Trim side bends check box selected.

Figure 16-24  Edge flange created with the
Trim side bends check box cleared

Figure 16-25  Edge flange created with the
Trim side bends check box selected
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Offset
The Offset check box is available only when you create an edge flange with the Material
Inside, Material Outside, or Bend Outside options. This check box is used to create an
edge flange at an offset distance from the selected edge reference. When you select the
Offset Distance check box, the Offset End Condition drop-down list and the Offset
spinner are displayed. Using this, you can define the offset distance. Figure 16-26 shows
the edge flange created using the Offset check box cleared. Figure 16-27 shows the edge
flange created using the Offset check box selected and the offset distance using the Offset
Distance spinner selected.

Custom Bend Allowance
The Custom Bend Allowance rollout is used to define the bend allowance other than the
default bend allowance that you defined while creating the base flange. To apply the custom
bend allowance, select the Custom Bend Allowance check box to invoke this rollout. Using
the options available in this rollout, you can define the bend allowance for the current bend
as discussed earlier.

Custom Relief Type
The Custom Relief Type rollout is used to define the type of relief other than the default
relief type that you defined while creating the base flange. To apply the custom relief, select
the Custom Relief Type check box to invoke the Custom Relief Type rollout as shown in
Figure 16-28.

Figure 16-26  Edge flange created with the
Offset check box cleared

Figure 16-27  Edge flange created with the
Offset check box selected

Figure 16-28  The Custom Relief Type rollout
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The types of reliefs that you can define for a sheet metal component are discussed next.

Obround Relief
The Obround Relief option is used to apply the rectangular relief such that the edges of
the relief merging with the sheet are rounded. The Use relief ratio check box is selected
by default. Therefore, using the Relief Ratio spinner you can modify the value of the
relief ratio. If you clear the Use relief ratio check box, the Relief  Width and the Relief
Depth spinners are displayed as shown in Figure 16-29. Using these two spinners, you
can modify the relief width and relief depth individually.

Figure 16-30 shows the edge flange created by providing obround relief with the default
relief ratio. Figure 16-31 shows the edge flange created by providing obround after
modifying the width and depth values.

Rectangular Relief
The Rectangular Relief option is selected by default. This option specifies the rectangular
relief to the sheet metal components. Other options available for defining the rectangular
relief are the same as discussed above. Figure 16-32 shows the edge flange created by
providing rectangular relief with the default relief ratio. Figure 16-33 shows the edge
flange created by providing rectangular relief after modifying the relief ratio.

Figure 16-30  Edge flange created with default
relief ratio

Figure 16-31  Edge flange created after
modifying the relief ratio

Figure 16-29  The Custom Relief Type rollout with the Obround
option selected from the Relief Type drop-down list

c16-solidworks-2003.p65 7/23/2003, 12:18 PM15
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Figure 16-34  The Custom Relief Type rollout with the
Tear option selected from the Relief Type drop-down list

Figure 16-32  Edge flange created with default
relief ratio

Figure 16-33  Edge flange created after modifying
the relief ratio

Tear Relief
Using the Tear option, you can specify the tear relief to the edge flange. The tear relief
will tear the sheet in order to accommodate the bending of the sheet. When you select the
Tear option from the Relief Type drop-down list, all the other options are replaced by
the Rip and the Extend buttons as shown in Figure 16-34.

The Rip button is chosen by default. This option rips or tears the sheet that will
accommodate the bending of the sheet. When the Extend button is chosen, the outer
faces of the bend are extended to the outer faces of the sheet on which you are creating
the edge flange. Figure 16-35 shows the edge flange created with the Rip button selected
in the tear relief. Figure 16-36 shows the edge flange created with the Extend button
selected in tear relief.

Creating Tabs

Adding a tab feature is the process of adding material to the walls of the sheet metal
component. To create a tab, select the face that you need to select as the sketching
plane and create the sketch of the tab. Remember that the sketch must be closed.

Now, choose the Base-Flange/Tab button from the Sheet Metal toolbar or choose Insert >
Sheet Metal > Tab from the menu bar. A tab will be created and the thickness of the tab is

Toolbar: Sheet Metal > Base-Flange/Tab
Menu: Insert > Sheet Metal > Tab

c16-solidworks-2003.p65 7/23/2003, 12:18 PM16
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Figure 16-35  Tear relief with Rip button selected Figure 16-36  Tear relief with Extend button
selected

automatically adjusted to the thickness of the sheet. Figure 16-37 shows the sketch for creating
a tab and Figure 16-38 shows the resultant tab.

Creating the Sketched Bend

The Sketched Bend tool is used to create a bend using a sketch as the bending line.
To create a sketched bend, select the face of the sheet on which you need to create a
bend line and invoke the sketching environment. Using the Line tool, create a line to

define the bend line. Now, choose the Sketched Bend button from the Sheet Metal toolbar.
The Sketched Bend PropertyManager is invoked as shown in Figure 16-39 and you are
prompted to specify the planar face to be fixed when creating the bend. Select the side of the
sheet that will be fixed when you create the bend. A black sphere is displayed on the selected
point that you need to keep fixed and the Reverse Direction arrow is also displayed to reverse

Figure 16-37  Sketch for creating the tab Figure 16-38  Resultant tab

Toolbar: Sheet Metal > Sketched Bend
Menu: Insert > Sheet Metal > Sketched Bend
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Figure 16-40  Sketch line and the face to be fixed

Figure 16-39  The Sketched Bend PropertyManager

the direction of bend creation. You will notice that the Bend Centerline button is chosen by
default in the Bend position area. This button is chosen to create the bend equally on both
the sides of the bend line. The other options available in the Sketched Bend PropertyManager
are the same as those discussed earlier. After setting all the parameters, choose the OK button
from the Sketched Bend PropertyManager. Figure 16-40 shows the sketch to be used as the
bend line and the side of the face to be fixed while bending. Figure 16-41 shows the resultant
bend.

c16-solidworks-2003.p65 7/23/2003, 12:18 PM18



Sheet Metal Design       16-19

©
 C

A
D

C
IM

 T
ec

hn
ol

og
ie

s,
 U

S
A

. 
Fo

r 
en

gi
ne

er
in

g 
se

rv
ic

es
, 

co
nt

ac
t 

sa
le

s@
ca

dc
im

.c
om

Figure 16-41  Resultant sketched bend

Note
You can also create more than one sketch line for creating multiple bends using single sketch
bend feature. But you need to make sure that the bend sketches do not intersect each other.
Figure 16-42 shows the sheet and two bend lines and Figure 16-43 shows the resultant bends.

Creating the Miter Flange

The Miter Flange tool is used to create a series of flanges along the edges of the sheet
metal component. The profile of the miter flange is defined by the sketch created on
a sketching plane normal to the direction of extrusion of flange. To create a miter

flange, select the sketching plane and invoke the sketching environment. Create the sketch

Figure 16-42  Two bend lines Figure 16-43  Resultant sketched bend

Toolbar: Sheet Metal > Miter Flange
Menu: Insert > Sheet Metal > Miter Flange
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Figure 16-44  The Miter Flange PropertyManager

for the miter flange, and then choose the Miter Flange button from the Sheet Metal toolbar.
The Miter Flange PropertyManager is displayed as shown in Figure 16-44.

The preview of the flange with the default settings is displayed in the drawing area. You are
also prompted to select the linear edge(s) to attach the milter flange. Figure 16-45 shows the
sketch for creating the milter flange and Figure 16-46 shows the preview of the miter flange.
Now, select the other edges if required and choose the OK button from the Miter Flange
PropertyManager. Figure 16-47 shows the sketch and the other edges to be selected to create
the miter flange. Figure 16-48 shows the resultant miter flange.

The other options available in the Miter Flange PropertyManager area discussed next.

Gap distance
The Gap distance option available in the Miter Parameters rollout is used to define the rip
distance between two consecutive flanges. The distance value of the rip is modified using the Rip
Gap spinner. Sometimes, while creating a miter flange, if the feature creation is aborted due to
default rip distance, the Rebuild Errors dialog box is displayed and you are prompted to enter
a larger distance value. Figure 16-49 shows the miter flange created using default distance value
and Figure 16-50 shows the miter flange created using modified rip distance.
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Figure 16-45  Sketch for creating miter flange Figure 16-46  Preview of the miter flange

Figure 16-47  Sketch and additional edges to select Figure 16-48  Resultant miter flange

Figure 16-49  Miter flange with default rip gap Figure 16-50  Miter flange with modified rip
gap
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Start/End Offset
Using the options available in the Start/End Offset rollout, you can specify the start and end
offset distances of the miter flange. The Start Offset Distance spinner is used to specify the
offset distance from the start face of the miter flange. The End Offset Distance spinner is
used to specify the offset distance from the end face of the miter flange. If the start and end
offset distances are applied to the miter flange created on one edge, the resultant flange will
be at some offset from start and end face. If the start and end offset distances are applied to
the miter flange created using all the edges of the base flange, the start offset distance is
applied to the start face of the miter flange and the end offset distance is applied to the end
of the face miter flange. Figure 16-51 shows the miter flange on the single edge with the start
and end offsets. Figure 16-52 shows the offsets applied to the miter flange created by selecting
all the edges of the base flange.

Creating Closed Corners

In SolidWorks, you can also close the corners of the sheet metal components that
remain open due to rip gap or relief. You can close the corners using the Closed
Corner tool. To create a closed corner, choose the Closed Corner button from the

Sheet Metal toolbar, the Closed Corner PropertyManager is invoked as shown in Figure 16-53.
You are prompted to select planar corner face(s) to extend to create a closed corner. Select the
face or the edge that you need to extend as shown in Figure 16-154. The selected face is
highlighted in green. Remember that you cannot close the face of the flange using another
flange that is not at 90-degree. That means to close the corner, both the flanges must be
normal to each other. After selecting the faces, select the type of corner that you need to

Figure 16-51  Offset distances applied to the miter
flange created by selecting single edge

Figure 16-52  Offset distances applied to the
miter flange created by selecting all the edges

Tip. While creating the miter flange, if the there is any edge tangent to the selected
edge then  symbol is displayed. By selecting this symbol, all the edges tangent to
the selected edge are automatically selected.

Toolbar: Sheet Metal > Closed Corner
Menu: Insert > Sheet Metal > Closed Corner
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Figure 16-53  The Closed Corner PropertyManager

Figure 16-54  Face selected to create a closed
corner

Figure 16-55  Closed corner with Butt option

create from the option provided in the Faces to Extend rollout. The preview of the closed
corner is displayed in the drawing area. Choose the OK button from the Closed Corner
PropertyManager. Figures 16-55 through 16-57 show the preview of the closed corner using
Butt, Overlap, and Underlap options respectively.
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Figure 16-56  Closed corner with Overlap
option

Figure 16-57  Closed corner with Underlap
option

Figure 16-58  The Hem PropertyManager

Toolbar: Sheet Metal > Hem
Menu: Insert > Sheet Metal > Hem

Creating Hems

Hems are generally used to bend a small area of sheet in order to eliminate the sharp
edges in a sheet metal component. To create a hem, choose the Hem button from the
Sheet Metal toolbar, the Hem PropertyManager is invoked as shown in Figure 16-58.
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Figure 16-59  Edge selected to create closed hem Figure 16-60  Resultant closed hem

You are prompted to select an edge on a planar face to create a hem feature. Select the edge
on a planar face, the preview of the hem with the default settings is displayed in the drawing
area. The options available in the Hem PropertyManager are discussed next.

Edges
The options available in the Edges rollout are used to specify edges on which you need to
apply the hem. As you select the edges, the name of the edges is displayed in the Edges
display area and the preview of the hem is displayed. The Reverse Direction button is choosen
to reverse the hem direction.

By default, the Material Inside button is chosen in the Edges rollout. Using this button, the
hem is created with the material of the hem inside the maximum limit of the sheet. If you
select the Bend Outside button, then the hem is created with the bend starting from outside
the maximum limit of the sheet.

Type and Size
The Type and Size rollout is used to define the type of hem and the size of hem that you need
to create. The types of hem that you can create using the options available in this rollout are
discussed next.

Closed Hem
You can create closed hem by choosing the Closed button from the Type and Size rollout.
After selecting this button, you need to set the length of the closed hem using the Length
spinner. If you select more than one edge to create the hem, the Miter Gap rollout is
displayed and using this you can specify the rip gap. Figure 16-59 shows the edge
selected to create closed hem and Figure 16-60 shows the resultant closed hem.

Open Hem
You can create the open hem by choosing the Open button from the Type and Size
rollout. When you choose this button, the Length and the Gap Distance spinners are
displayed. You can specify the value of the length and the gap distance in these spinners.
Figure 16-61 shows the edge to be selected and Figure 16-62 shows the resultant open
hem.
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Figure 16-61  Edge selected to create open hem Figure 16-62  Resultant open hem

Tear Drop Hem
The Tear Drop button is used to create the tear drop shape of hem. This button is chosen
by default when you invoke the Hem PropertyManager. When this button is chosen, the
Angle and Radius spinners are displayed to set the value of angle and spinner.

Rolled Hem
The Rolled button is used to create the rolled shaped hem. When you chosen this button,
the Angle and Radius spinners are displayed to set the respective values.

Figure 16-63 shows the tear drop hem and Figure 16-64 shows the rolled hem created on
a sheet metal component.

Figure 16-63  Tear drop hem Figure 16-64  Rolled hem
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Figure 16-65  The Jog PropertyManager

Creating a Jog Bend

SolidWorks allows you to create a jog bend that consists of two bends created using a
sketched line. The line is sketched on the face of the sheet metal component from
where you need to create the jog bend. For creating a jog bend, first create a straight

line that defines the bend line and choose the Jog button from the Sheet Metal toolbar, the
Jog PropertyManager is displayed as shown in Figure 16-65.

You are prompted to select the planar face to be fixed when creating the bend. As you select
the side of the face to be fixed, the preview of the jog bend with the default values is displayed
in the drawing area. Figures 16-66 and 16-68 show the bend line and the faces to be fixed and
Figures 16-67 and 16-69 show the respective resultant jog bends. The options available in the
Jog PropertyManager are discussed next.

Toolbar: Sheet Metal > Jog
Menu: Insert > Sheet Metal > Jog
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Selections
The options available in the Selections rollout are used to define the face to be fixed while
bending and to define the radius of the bend. The name of the selected face that needs to be
fixed while bending is displayed in the Fixed Face display area. By default, the Use default
radius check box is selected. If you need to define the bending radius other than the default
radius, clear the Use default radius check box and set the value of the radius in the Bend
Radius spinner.

Jog Offset
The Jog Offset rollout is used to define various parameters of the jog. Using this rollout, you
can define the feature termination option for the jog. You can also create a jog with 0mm
blind depth. The other options available in this rollout are discussed next.

Dimension position
The options available in the Dimension position area of the Jog Offset rollout are used
to define the position from where the dimension of the jog offset is calculated. The buttons

Figure 16-66  Bend line and face to fix Figure 16-67  Resultant jog bend

Figure 16-68  Bend line and face to fix Figure 16-69  Resultant job bend
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Figure 16-70  Inside dimension, outside dimension, and overall dimension

available in this area are used to specify the offset by calculating the inside offset, outside
offset, and the overall dimension, refer to Figure 16-70.

Fix projected length
The Fix projected length check box is selected by default and is used to maintain the
length of the bended sheet equal to the projected length of the original sheet after adding
a jog bend. If you clear this check box, then the overall length of the sheet is maintained
equal to the original sheet even after adding the jog bend. Figure 16-71 shows the bend
line that will be used to create a jog bend. Figure 16-72 shows the jog bend created with
Fixed projected length check box selected. Figure 16-73 shows the jog bend created with
the Fixed projected length check box cleared.

Figure 16-71  Bend line to create the jog bend
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Figure 16-72  Jog bend created with the Fixed
projected length check box selected

Figure 16-73  Jog bend created with the Fixed
projected length check box cleared

Jog Position
The Jog Position rollout is used to define the position of bending. The options available in
this rollout are similar to those discussed earlier.

Jog Angle
The Jog Angle rollout is available to define the angle of the jog bend. The default value of the
jog angle is 90-degree. Using the Jog Angle spinner, you can set the value of the angle at
which you need to create the jog bend. Figure 16-74 shows the jog bend created at an angle of
135-degree.

Figure 16-74  Jog bend created at an angle of 135-degree
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Breaking the Corners

In SolidWorks, you are provided with an option to break the edges of the sheet metal
components to create chamfer or fillet. The edges of the sheet metal components are
chamfered or filleted using the Break-Corner/Corner-Trim tool. To invoke this tool,

choose the Break-Corner/Corner-Trim button from the Sheet Metal toolbar. The Break Corner
PropertyManager is invoked as shown in Figure 16-75.

You are prompted to select corner edge(s) or flange(s). Select the faces or edges that you need
to break. The preview of the corner break is displayed in the drawing area using the default
settings. As the Chamfer button is chosen by default in the Break Corner Options area, the
corner break created by default is a chamfer. You can set the value of the chamfer using the
Distance spinner. If you need to create a corner break as fillet, choose the Fillet button from
the Break Corner Options rollout. The Distance spinner is replaced by the Radius spinner.
After setting all the parameters, choose the OK button from the Break Corner
PropertyManager. Figure 16-76 shows the sheet metal component with the chamfers and
fillets added using the Break Corner PropertyManager. The other options available in this
tool are available only after you create the flat pattern of the sheet metal component. Therefore,
these options are discussed later in this chapter.

Figure 16-75  The Break Corner PropertyManager

Toolbar: Sheet Metal > Break-Corner/Corner-Trim
Menu: Insert > Sheet Metal > Break Corner
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Figure 16-76  Chamfers and fillets added to the sheet metal component

Creating Cuts on Planar Faces of the Sheet Metal
Components

SolidWorks also allows you to create cuts in the sheet metal components. Creating
cuts in the sheet metal components is similar to creating cuts in the solid models. To
create cuts on the planar faces of the sheet metal components, select the face or the

plane as the sketching plane and invoke the sketching environment. Draw the sketch for
creating the cut feature and choose the Extruded Cut button from the Features toolbar. Set
the options for feature termination in the Cut-Extrude PropertyManager. You will observe
that some additional options are displayed in the Cut-Extrude PropertyManager. These
additional options are discussed next.

Link to thickness
The Link to thickness check box is used to set the value of the feature termination according
to the thickness of the sheet. When you select this check box, the cut feature will be terminated
at the blind distance equal to the sheet thickness, irrespective of the feature termination
option selected.

Normal cut
The Normal cut check box is selected by default and is used for the bended sheet metal
components. If this check box is selected, the cut feature is created normal to the sheet thickness.
If you clear this check box, the cut feature is created normal to the sketching plane.
Figure 16-77 shows the side view of a sheet metal component in which a cut is created with the
Normal cut check box selected and a cut feature created with Normal cut check box cleared.

Toolbar: Features > Extruded Cut
Menu: Insert > Cut > Extrude
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Figure 16-77  Cut created with the Normal Cut check box selected
and cleared

Creating Lofted Bends

The lofted bends are created by defining a transition of sheet between two open
sections placed apart from each other at some offset distance. To create the lofted
bends, create the open section. Remember that the sections should not have vertices.

If the sections have vertices, replace them with fillets. Now, choose Insert > Sheet Metal >
Lofted-Bends from the menu bar. You can also invoke this tool using the Lofted-Bend button.
You need to customize the tool bar by adding this button. The Lofted Bends PropertyManager
is invoked as shown in Figure 16-78.

You are prompted to select two profiles. Select two profiles to create the lofted bends. As you
select two profiles, the preview of the lofted bend is displayed in the drawing area. Set the
thickness of the sheet using the Thickness spinner and choose the OK button from the
Lofted Bends PropertyManager. Figure 16-79 shows the open section that you need to select
for creating a lofted bend. Figure 16-80 shows the resultant lofted bend.

Toolbar: Sheet Metal > Lofted-Bend (Customize to Add)
Menu: Insert > Sheet Metal > Lofted-Bends

Figure 16-78  The Lofted Bends
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Creating Flat Pattern View of the Sheet Metal Component

In the tool room or in the machine shop, the flat pattern view of the sheet metal
component is extensively used to define the size of the raw sheet, and the shape of
the sheet that you need before bending. It is also used for process planning to start

the manufacturing of the tool that will create the sheet metal component. Before creating the
flat pattern, you can set the option of the flat pattern. To set the options of the flat pattern,
select the Flat-Pattern1 feature from the FeatureManager Design Tree and invoke the shortcut
menu. Choose the Edit Definition option from the shortcut menu. The Flat-Pattern
PropertyManager is invoked as shown in Figure 16-79. The options available in the Flat-Pattern
PropertyManager area discussed next.

Figure 16-79  Sections for creating lofted bend Figure 16-80  Resultant lofted bend

Toolbar: Sheet Metal > Flattened

Figure 16-81  The Flat-Pattern PropertyManager
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Parameters
The options available in the Parameters rollout are used to define various parameters to
create the flat pattern of the sheet metal component. The options available in this rollout are
discussed next.

Fixed Face
The Fixed Face display area is used to specify the face that will be fixed while opening the
sheet to create the flat pattern. The selected face is highlighted in green and its name is
displayed in the Fixed Face display area. You can select any other face from the drawing
area that needs to be fixed while creating the flat pattern.

Merge faces
The Merge faces check box is used to merge the flat faces and the bending faces while
creating the flat pattern. This check box is selected by default. If you clear this check box,
the flat faces and bend faces are not merged. Figure 16-82 shows the flat pattern of a
sheet metal component with the Merge faces check box selected. Figure 16-83 shows the
flat pattern of a sheet metal component with the Merge faces check box cleared.

Simplify bends
The Simplify bends check box is selected to straighten the curved edges of the sheet
metal component in the flat pattern. This check box is selected by default. If you clear
this check box, the curved edge is displayed as it is in the flat pattern.

Figure 16-82  Flat pattern with Merge faces
check box selected

Figure 16-83  Flat pattern with Merge faces
check box cleared
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Corner Options
The Corner Options rollout is used to set the options to dress up the corners of the flattened
sheet metal component. Using the options from the Corner Options rollout, the flat pattern
of the sheet metal component is the final flatten sheet that will be used for manufacturing.
The options available in this rollout are discussed next.

Corner Treatment
The Corner Treatment check box is selected by default and is used to automatically
apply the corner treatment to the flattened sheet. This option removes or adds the material
at the corners of the sheet. If you clear this check box, the corner treatment is not applied
to the flattened sheet. Figure 16-84 shows the flat pattern of a sheet metal component
with the Corner Treatment check box selected. Figure 16-85 shows the flat pattern of a
sheet metal component with the Corner Treatment check box cleared.

Add Corner-Trim
The Add Corner-Trim check box is used to trim the corners of the flattened sheet metal
component to provide reliefs. The reliefs applied using this method are only displayed in
the flat pattern. When you select the Add Corner-Trim some additional options are
displayed in the Corner Options rollout as displayed in Figure 16-86. These options are
discussed next.

Break corners
When you select the Add Corner-Trim check box, the Break corners check box
appears. If you select the Break corners check box, the options to break the corners
using the fillet and chamfer are displayed. These options are similar to those discussed
earlier. The only difference is that the fillet or chamfer created using this option is
only displayed in the flat pattern.

Relief Type
The options available in the Relief Type drop-down list is used to specify the type of
relief or corner-trim you need to apply to the corners of the flatten sheet metal

Figure 16-84  Flat pattern with the Corner
Treatment check box selected

Figure 16-85  Flat pattern with the Corner
Treatment check box cleared
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Figure 16-84  The Corner Options rollout after
selecting the Add Corner-Trim check box

Figure 16-87  Circular relief Figure 16-88  Square relief

component. The types of reliefs that you can define using this drop-down list are
displayed in the Figures 16-87 through 16-89. Using the other options, you can set
the size of relief.

Figure 16-89  Bend waist relief
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After setting all the options, choose the OK button from the Flat-Pattern PropertyManager.
You will observe that the Corner-Trim1 feature is displayed in the FeatureManager Design
Tree. If you need to edit the corner trim, select the Corner-Trim1 from the
FeatureManager Design Tree and invoke the shortcut menu. Choose the Edit Definition
from the shortcut menu to edit the corner trim. Now, to flatten the sheet metal component,
choose the Flattened button from the Sheet Metal toolbar. You can also select the Flat-Pattern1
feature from the FeatureManager Design Tree and invoke the shortcut menu. Choose the
Unsuppress option from the shortcut menu to flatten the sheet metal component. The sheet
metal component is flattened by selecting the base flange as the face of the sheet to be
fixed. Figure 16-90 shows a sheet metal component and Figure 16-91 shows its resultant
flattened state.

Figure 16-90  Sheet metal component

Figure 16-91  Flat pattern of the sheet metal component
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CREATING SHEET METAL COMPONENTS FROM A
FLAT SHEET
SolidWorks also provides you an option to create the sheet metal component by first creating
the flat pattern of the sheet and then add bends to it to get the required shape of the
component. Consider an example of the sheet metal component shown in Figure 16-92.

To create this component using this method, you first need to create the base flange using the
Base Flange/Tab tool as shown in Figure 16-93. Next, this creates the bend lines as shown in
Figure 16-94. Now, with the Sketched Bend tool, bend the sheet metal component using the
sketch created earlier as the bending lines. You can also add other sheet metal features to
complete the component.

Figure 16-92  Sheet metal component

Figure 16-93  Base flange Figure 16-94  Bend lines
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CREATING THE SHEET METAL COMPONENT FROM
THE FLAT PART
SolidWorks also provides you with an option to create a sheet metal component by creating
the flat state of the sheet as a solid part and then converting the solid part into sheet metal. To
create a sheet metal component using this method, create the closed sketch of the sheet metal
component that will define the flat state of the sheet. Extrude the sketch using the blind
depth equal to the thickness of the flat sheet. Next, convert the flat part into a sheet metal
component in flattened state. The procedure of converting the flat part into a sheet metal
component is discussed next.

Converting Part or Flat Part into Sheet Metal by Adding
Bends

For converting a part into a sheet metal component, you need to add bends in the
part. The bends are added to the part using the Insert Bends tool. To invoke this
tool, choose the Insert Bends button from the Sheet Metal toolbar; the Bends

PropertyManager is invoked. The partial view of the Bends PropertyManager is displayed
in Figure 16-95.

You are prompted to select the fixed face or edge and set the bend parameters. Select the top
face of the flat part as shown in Figure 16-96. The selected face is highlighted in green and

Figure 16-95  Partial view of the Bends PropertyManager

Toolbar: Sheet Metal > Insert Bends
Menu: Insert > Sheet Metal > Bends
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Figure 16-96  Face selected to be fixed

the name of the face is displayed in the Fixed Face or Edge display area. Set the parameters
of the bend allowance and the relief in the Bend Allowance and Auto Relief rollout respectively.
After specifying all these parameters, choose the OK button from the Bends PropertyManager.
The SolidWorks warning message window is displayed as shown in Figure 16-97. It informs
you that no bends are found. Choose the OK button from the SolidWorks warning message
window.

Although no bends are added to the flat part, you will observe that the flat part is converted
into a sheet metal part and some new features are added to the FeatureManager Design
Tree. These options are discussed later in this chapter.

Adding Bends to the Flatten Sheet Metal Component
After converting the flat part into a sheet metal component, you need to add the bends to
create the sheet metal component. Generally, there are two methods of adding bends to the
flattened sheet metal components that are extracted from a flat part. The first option is to
create sketch bends that are already discussed earlier in this chapter. The second method of
creating the bends is discussed next.

Figure 16-97  The SolidWorks warning message window
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Creating Sketched Bends using the Process Bends Method
The process bends method is used to create sketched bends in the sheet metal component
extracted from a part. These bends are also called Flat Bends. All the bends created using the
bending lines are placed in the Process-Bends1 folder in the FeatureManager Design Tree.
To create the bends using this method, expand the Process-Bends1 folder and select the
Flat-Sketch1. Invoke the shortcut menu and choose the Edit Sketch option. The sketching
environment in invoked. Create the sketch of the bending lines  and exit the sketcher
environment. As you exit the sketcher environment, the sheet metal component will be bended
along the bend lines. If you expand the Process-Bends1 feature, you will observe that all the
bending features that you have added using the process bends are displayed. Figure 16-98
shows the sketches that will be used as bend lines to create the bends. Figure 16-99 shows the
resultant bended sheet metal component.

Note
All the options available in the FlatBend PropertyManager are the same as discussed
earlier, except the Bend Reorder option. Using this option, you can reorder the
sequence in which the bends are added to the sheet metal component.

Unbending the Sheet Metal Part Using the No Bends Tool

The No Bends tool is used to unbend the sheet metal component and roll it back to
the stage where it was not having any bends. Choose the No Bends button from the
Sheet Metal toolbar to rollback the component to the stage where no bends were

added. You can also rollback the sheet metal component by rolling up the rollback bar above
the Flatten-Bends1 feature from the FeatureManager Design Tree.

Figure 16-98  Bend lines Figure 16-99  Resultant bending

Tip. If you need to edit the radius of the bends individually, expand the
Process-Bends1 feature from the FeatureManager Design Tree. Select the bend
that you need to modify and invoke the shortcut menu. Choose the Edit Definition
option from the shortcut menu. The FlatBend PropertyManager is displayed,
that you can use to edit the parameters of the bend.

Toolbar: Sheet Metal > No Bends

c16-solidworks-2003.p65 7/23/2003, 12:18 PM42



Sheet Metal Design       16-43

©
 C

A
D

C
IM

 T
ec

hn
ol

og
ie

s,
 U

S
A

. 
Fo

r 
en

gi
ne

er
in

g 
se

rv
ic

es
, 

co
nt

ac
t 

sa
le

s@
ca

dc
im

.c
om

Figure 16-100  Extruding the flange Figure 16-101  After rolling back the model to the
bend state

Note that if you add an extruded feature to the unbent part such that the depth of the extruded
feature is equal to the sheet thickness, it is automatically converted into a flange when you
resume the sheet metal part. Consider the model shown in Figure 16-100. This figure shows
an extruded feature added to an undent sheet metal part.

Now, if you choose the No Bends button from the Sheet Metal toolbar or roll the rollback bar
to the end from the FeatureManager Design Tree, the flange with the default setting of
bending and relief is created as shown in Figure 16-101. If you need to specify custom bending
and relief, expand the Flatten-Bends1 from the FeatureManager Design Tree and select the
SharpBend1. Invoke the shortcut menu and choose the Edit Definition option from the
shortcut menu. Using the PropertyManager you can define the custom parameters of bend
radius, bend allowance, and relief.

Tip. Remember that if the original sketch of the sheet metal part had multiple lines
at an angle to each other, such as the L or U sections, they will not be unbent.
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CREATING THE SHEET METAL COMPONENT BY
DESIGNING IT AS A PART
SolidWorks also provides you with an option to first design the entire Part in the part mode
and then convert the part into a sheet metal component. Consider an example of a sheet
metal part as shown in Figure 16-102. For creating this component, create the design of the
sheet metal component using the part modeling tools as shown in Figure 16-103.

After designing it as a part, invoke the Bends PropertyManager and select a face that will be
fixed. Specify the sheet metal parameters and choose the OK button from the Bends
PropertyManager. If some reliefs are to be added to the sheet metal component, then the
SolidWorks warning message window is displayed and you are informed that auto relief cuts
were made for one or more bends. Choose the OK button from this message window. You will
get the desired sheet metal part. Figure 16-104 shows the flat pattern of the above shown
sheet metal component.

Tip. If you need to create the flat pattern of a sheet metal component which is
created by converting if from the part, then choose the Flattened button from the
Sheet Metal toolbar. You will observe that the Flat-Pattern1 feature is not available
in the FeatureManager Design Tree.

The Flat-Pattern1 feature is only available in the FeatureManager Design
Tree if you create at least one sheet metal feature such as tab, hem, edge flange, and
so on using the options available in the Sheet Metal toolbar.

Figure 16-102  A sheet metal component Figure 16-103  Component designed as part
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Understanding Types of Bends
Now, you need to learn various types of bends that are added to sheet metal components
when you create the sheet metal component by converting a part into sheet metal. The types
of bends that are added to the sheet metal component created by conversion are discussed
next.

Sharp Bends
If you create a part with sharp edges and convert it into a sheet metal component, then the
bends added to the sheet metal component are recognized as sharp bends. Figure 16-105
shows a part created with sharp edges. Figure 16-106 shows the part converted into sheet
metal component. The bends added in this component are the sharp bends. The sharp bends
are placed in the Flatten-Bends1 feature in the FeatureManager Design Tree.

Figure 16-104  Flat pattern of the sheet metal component

Figure 16-105  Part created with sharp edges Figure 16-106  Part converted into sheet metal
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Round Bends
If you create a part with rounded edges and convert it into a sheet metal component, then the
bends added to the sheet metal component are recognized as rounded bends. Figure 16-107
shows a part created with rounded edges. Figure 16-108 shows the part converted into sheet
metal component. The bends added in this component are the rounded bends. The rounded
bends are placed in the Flatten-Bends1 feature in the FeatureManager Design Tree.

Flat Bends
The flat bends are the bends that are created by bending the flattened sheet. Bends created
using the bend lines created in the Flat-Sketch1 are recognized as flat bends. Creating these
type of bends is discussed earlier. The flat bends are placed in the Process-Bends1 feature in
the FeatureManager Design Tree.

DESIGNING A SHEET METAL PART FROM A SOLID
SHELLED MODEL
SolidWorks also provides you with an option of designing the sheet metal part as a solid
model and then shelling the model. Remember that while shelling the model you need to
remove at least one face also. After shelling the model, you need to rip the edges of the thin
solid model. The ripping is done in order to cut the sheet so that it can be opened easily while
creating the flat pattern. Therefore, before converting the shelled solid part into a sheet
metal component, you first need to add the ripping to the edges of the solid part. Ripping
the edges of a solid part are discussed next.

Ripping the Edges

The Rip tool is used to add a gap between the edges of the shelled solid part before
converting it into a sheet metal component. To rip the edges, choose the Rip button
from the Sheet Metal toolbar. The Rip PropertyManager is invoked as shown in

Figure 16-107  Part with rounded edges Figure 16-108  Part converted into sheet metal
component

Toolbar: Sheet Metal > Rip
Menu: Insert > Sheet Metal > Rip
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Figure 16-109  The Rip PropertyManager

Figure 16-109 and you are prompted to set the rip gap and select the edge(s) to rip. Select the
internal edges that you need to rip, the direction arrows are displayed on the selected edge.
The name of the selected edge is also displayed in the Edge to Rip display area. You will
observe that two arrows are displayed, this means the ripping will be done on both the sides
of the selected edge. Using the Change Direction button, you can toggle between the two
directions, first direction, and second direction.

You will notice that the Use default gap check box is selected by default. The default gap of the
rip is 1mm and using this check box the rip will be created with a gap of 1mm. If you clear this
check box, then Rip Gap spinner is displayed that you can use to set the value of the rip gap.

Figure 16-110 shows the edge selected to create the rip in both directions. Figure 16-111
shows the resultant rip created.

After ripping the edges, invoke the Bends PropertyManager and select fixed face and set the
sheet metal parameters and choose the OK button from the Bends PropertyManager.
Figure 16-112 shows the shelled solid model and Figure 16-113 shows the model after ripping

Figure 16-110  Edge selected to rip Figure 16-111  Resultant rip
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and converting it into a sheet metal component. Figure 16-114 shows the flat pattern of the
sheet metal component.

CREATING CUTS IN SHEET METAL COMPONENTS
ACROSS THE BENDS
In this section, you will learn to create cuts across the bends as shown in Figure 16-115. The
methods of creating cuts across the bends are different for the sheet metal components

Figure 16-112  Shelled solid model Figure 16-113  Model after ripping and converting
it into a sheet metal component

Figure 16-114  Flat pattern of the sheet metal component

Tip. You can also rip the edges using the Rip Parameters rollout available in the
Bends PropertyManager.
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Figure 16-115  A sheet metal component with cuts across the bends

created from the base flange and the sheet metal component created by converting it from
the solid part. The methods for creating cuts for both types of sheet metal
components are discussed next.

Creating Cuts in the Sheet Metal Component Created from
a Solid Model
If you need to create a cut in a sheet metal component created by converting it from a solid
model, you first you need to create the flat pattern of the sheet metal component. Then,
select the face on which you need to create the cut and invoke the sketching environment.
Now, create the sketch for the cut feature and extrude the sketch to create the cut using the
Link to thickness option. Now, unflatten the sheet metal component, you will observe that
the cut is created across the bends. Consider an example of a sheet metal component shown
in Figure 16-116. Create the flat pattern of the sheet metal component as shown in
Figure 16-117. Select the top face of the flattened sheet metal component as the sketching

Figure 16-116  Sheet metal component Figure 16-117  Flat pattern of sheet metal
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plane and invoke the sketching environment. Create the sketch and extrude the cut using the
Link to thickness option. After creating the cut, use the Linear Pattern tool to create a linear
pattern of the cut feature. The flattened sheet metal component after creating and patterning
the cut feature is shown in Figure 16-118. Now, unflatten the sheet metal component, the
final sheet metal component after creating cuts across the bends is shown in Figure 16-119.

Creating Cuts in the Sheet Metal Component Created
Using the Base Flange
The sheet metal component designed using the base flange does not include the
Flatten-Bends1 and the Process-Bends1 features. Therefore, for creating cuts in this type of
sheet metal component, you first need to unfold the sheet using the Unfold tool and then
create the cut feature. After creating the feature, you need to fold the sheet back using the
Fold tool. Consider an example of the sheet metal component displayed in Figure 16-120.
For creating cuts in this sheet metal component, you first need to unfold the sheet. The
method of unfolding the sheet is discussed next.

Figure 16-118  Flatten sheet after creating and
patterning the cuts

Figure 16-119  Final sheet metal component

Tip. In a sheet metal component created by converting from a solid model, if you
add a sheet metal feature such as hem, edge flange or so on, then the Flat-Pattern1
feature is also added in the FeatureManager Design Tree. For creating a cut
across the bends in this type of component, you need to roll back the rollback bar up
to Process-Bends1 feature to create cuts on the flatten sheet.

If you use the Flatten button from the Sheet Metal toolbar to create the cuts on the
flattened sheet, cuts will not be displayed in the unflattened sheet metal component.
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Figure 16-121  The Unfold PropertyManager

Figure 16-120  A sheet metal component

Toolbar: Sheet Metal > Unfold
Menu: Insert > Sheet Metal > Unfold

Unfolding the Sheet

To unfold the sheet, you need to invoke the Unfold tool by choosing the Unfold
button from the Sheet Metal toolbar. The Unfold PropertyManager is invoked as
shown in Figure 16-121 and you are prompted to select a face of a linear edge on the

end face of a cylinder to remain fixed and the bends to be unfolded.
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Select the face that you need to fix and select the bends that you need to unfold. If you need
to unfold all the bends, choose the Collect All Bends button. Choose the OK button from the
Unfold PropertyManager. You will notice that the sheet metal component is unfolded.
Figure 16-122 shows the unfolded sheet.

After unfolding the sheet, create the required cut feature. The unfolded sheet, after creating
the cut feature, is displayed in Figure 16-123.

After creating the cut feature on the unfolded sheet you need to again fold the sheet. The
sheet is folded using the Fold tool. Folding the sheet using the Fold tool is discussed next.

Folding the Sheet

To fold the unfolded sheet, choose the Fold button from the Sheet Metal toolbar. The
Fold PropertyManager is invoked as shown in Figure 16-124. You are prompted to
select a face or a linear edge on the end face of a cylinder to remain fixed and the

bends to be folded.

The face of the sheet that was fixed while unfolding the sheet is selected by default when you
invoke the Fold PropertyManager. You can also select any other face that you need to fix
other than the default selected face while folding the sheet. Choose the Collect All Bends
button to select all bends to be folded and then choose the OK button from the Fold
PropertyManager. Figure 16-125 shows the final sheet metal component after folding it using
the Fold tool.

Note
If you have created edge flanges, through the length of edges of the base flange, SolidWorks may
not fold the component back. It will give an error message and inform you that you need to turn
the Trim side bends option in the Edge-Flange PropertyManager of two of the edge flanges.

Figure 16-122  The unfolded sheet Figure 16-123  The unfolded sheet after creating
the cut feature

Toolbar: Sheet Metal > Fold
Menu: Insert > Sheet Metal > Fold
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Figure 16-124  The Fold PropertyManager

Figure 16-125  Sheet metal component after folding

WORKING WITH FORMING TOOLS
Forming tools are used as dies to form the sheet metal components. SolidWorks provides you
with some default forming tools that you can use to form the sheet metal components. These
forming tools are inserted into the sheet metal component using the Feature Palette window.
You can also create custom forming tools and save them in the Feature Palette window. In this
section of the chapter, you will learn to apply the default forming tools available in the Feature
Palette window on a sheet metal component. You will also learn how to create and save the
custom forming tools in the Feature Palette window.
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Applying Forming Tools on the Sheet Metal Components
To apply the forming tool on the sheet metal component, choose Tools > Feature Palette
from the menu bar. The Feature Palette window is displayed; double-click on the Palette
Forming Tools folder. Various folders are displayed in which the forming tools are saved as
shown in Figure 16-125.

Now, open the folder from which you need to drag and drop the forming tool. Select the type
of forming tool and drag the forming tool to the face of the sheet metal component where
you need to apply that tool. The preview of the forming tool is displayed in the drawing area
as shown in Figure 16-127. Note that the forming tool will act as a punch and its travel
depends upon the face on which you are dropping the form tool. Therefore, before placing
the form tool, make sure that the model is oriented in the required direction so that you can
place the tool on the desired face. Now, release the left mouse button to place the forming
tool. The sketcher environment is invoked and the Position form feature dialog box is
displayed. This dialog box prompts you to use the dimensioning and sketch modify tools to
place the form feature. Using the Modify Sketch dialog box, you can modify the placement
of the form tool. Add the required relations and dimensions to fully define the placement
sketch. Now, choose the Finish button from the Position form feature dialog box. The form
feature is placed on the sheet metal component. Figures 16-128 and 16-129 show the different
views of the sheet metal component after placing the form feature.

Figure 16-126  Feature Palette window with folders
in which the palette forming tools are saved
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Figure 16-127  Preview of the form tool being placed on the sheet metal component

Figure 16-128  Sheet metal component after
applying the form feature

Figure 16-129  Sheet metal component after
applying the form feature
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Creating Custom Forming Tools
SolidWorks also provides you with the option of creating custom forming tools other than the
default forming tools that are available in the Feature Palette window. After creating all the
features of the custom forming tool, you need to add a placement sketch to the tool. The
procedure of creating the custom forming tool is discussed next.

Creating the Punch
For creating the custom tool first you need to create the punch that will be used to form the
sheet metal component. Using the standard tools available in the Part mode, create the punch
or the form tool. Figure 16-130 shows a forming tool created using the standard tools available
in the Part mode.

Creating the Orientation Sketch
After creating the forming tool, you need to create the orientation sketch. The orientation
sketch is used to define the orientation in which the forming tool will be placed on the sheet
metal component. Generally, the orientation sketch comprises of the outer edges of the base
of the form tool. It should be noted that the orientation sketch should be the last feature of
the form tool. Figure 16-131 shows the orientation sketch created on the base of the form tool.

Option for Creating Opening in the Sheet Metal Component Using
the Form Tool
After creating the forming tool and the orientation sketch, you need to set the option to
create the opening in the sheet metal component using the forming tool. You need to change
the color of the face that needs to be opened in the formed sheet metal component. Select
the face and invoke the shortcut menu. Choose the Face Properties option from the shortcut
menu, the Entity Property dialog box is displayed. Set the value of Red to 255, Green to 0,
Blue to 0 and choose the OK button from the Entity Property dialog box.

Tip. It is recommended that you must create the flat pattern before placing the form
feature on a sheet metal component created with the Flatten-Bends1 and the
Process-Bends1 features.

To modify a placed form feature, double-click on the form feature in the
FeatureManager Design Tree. All the dimensions of the form feature are displayed.

To edit the placement of the placed form feature, expand the form feature from the
FeatureManager Design Tree and select the Sketch feature. Invoke the shortcut
menu and choose the Edit Sketch option from the shortcut menu to edit the placement
sketch.

You can also edit the default form tools available in the Feature Palette window.
To edit the form tool, select the form tool and invoke the shortcut menu. Choose the
Edit Palette Item from the shortcut menu. The form tool will be opened in the
separate window. Now, you can edit the form tool.
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Figure 16-130  Form tool created using the
standard modeling tools

Figure 16-131  Orientation sketch created on the
base of the form tool

Saving the Forming Tool in the Feature Palette Window
Next, you need to save the forming tool in the Feature Palette window. Before saving it in the
Feature Palette window, you need to save it in the memory of the hard drive of your computer.
After saving the forming tools once in the required location, invoke the Feature Palette window.
Double-click on the Palette Forming Tools folder. Now, select the name of the forming tool
from the FeatureManager Design Tree and drag the forming tool to the Feature Palette
window. Release the left mouse button to drop the forming tool. The Save As dialog box is
displayed; specify the name of the forming tool and save the part.

Figure 16-132 shows the sheet metal component after placing and patterning a custom forming
tool.

Figure 16-132  Formed sheet metal component created using
customized forming tool
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CREATING CYLINDRICAL AND CONICAL SHEET METAL
COMPONENTS
SolidWorks also allows you to create cylindrical and conical sheet metal components. For
creating a cylindrical or a conical sheet metal component you need to make sure that the
cylinder or the cone should not be created along complete 360-degree. There should be
some gap to unfold the sheet. Create the conical or a cylindrical sheet metal part and invoke
the Bends PropertyManager to convert the part into sheet metal. Now, select a linear edge of
the conical or cylindrical part that will be fixed, refer to Figure 16-133. Choose the OK button
from the Bends PropertyManager. Next, choose the Flattened button. Figure 16-134 shows
the flat pattern of the conical sheet metal component.

Note
If you create the cylindrical or conical sheet metal component by lofting, you can directly use the
Flat Pattern option to create the flat pattern.

GENERATING THE DRAWING VIEW OF THE FLAT
PATTERN OF THE SHEET METAL COMPONENT
After creating the sheet metal component, the next step that you need to follow is to create
the drawing view of the flat pattern of the sheet metal component. For generating the drawing
view of the flat pattern of the drawing view, create a drawing view using the Named View tool.
Select the Flat Pattern option from the View Orientation rollout to generate the drawing
view of the flat pattern of the sheet metal component. Place the drawing view on the sheet.
Using the Flip View button available in the Flat Pattern Options rollout, you can flip the
direction of the flat pattern. Figure 16-135 shows a sheet metal component and Figure 16-136
shows its resultant flat pattern view. Figure 16-137 shows the drawing view of the flat pattern
of the sheet metal component.

Figure 16-133  Edge selected to be fixed Figure 16-134  Flat pattern of the conical sheet
metal component
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Figure 16-135  Sheet metal component Figure 16-136  Flat pattern

Figure 16-137  Drawing view of the flat pattern

TUTORIALS

Tutorial 1
In this tutorial, you will create the sheet metal component shown in Figure 16-138. The flat
pattern of the sheet metal component is shown in Figure 16-139 and its views and dimensions
are shown in Figure 16-140. You will create this model by first creating the base flange. After
creating this model, you will create its flat pattern.     (Expected time: 45 min)
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Figure 16-138  Sheet metal component

Figure 16-139  Flat pattern of the sheet metal component

The steps to be followed to complete this tutorial are discussed next.

a. Create the base flange of the sheet metal component, refer to Figure 16-141.
b. Add the other required flanges to the sheet metal component, refer to Figures 16-142

through 16-150.
c. Add a hem to the right most flange, refer to Figures 16-151 through 16-152.
d. Create the flat pattern of the sheet metal component, refer to Figure 16-153.

Creating the Base Flange
For creating this sheet metal component, you first need to create the base flange. The
base flange will be created using a rectangular sketch drawn on the Front plane.

c16-solidworks-2003.p65 7/23/2003, 12:19 PM60



Sheet Metal Design       16-61

©
 C

A
D

C
IM

 T
ec

hn
ol

og
ie

s,
 U

S
A

. 
Fo

r 
en

gi
ne

er
in

g 
se

rv
ic

es
, 

co
nt

ac
t 

sa
le

s@
ca

dc
im

.c
om

Figure 16-140  Drawing views and dimensions of Tutorial 1

1. Create a new SolidWorks document in the Part mode.

2. Invoke the sketching environment using the Front plane as the sketching plane.

3. Create the sketch of the base flange. The sketch of the base flange consists of a rectangle,
refer to Figure 16-140.

4. Choose the Base-Flange/Tab button from the Sheet Metal toolbar. The Base
Flange PropertyManager is displayed.

5. Set the value of the Thickness spinner to 1 and choose the OK button from the Base
Flange PropertyManager.

Figure 16-141 shows the base flange created using the sketch created on the Front plane
as the sketching plane.
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Creating the First Edge Flange
After creating the base flange, you need to create the first edge flange. The first edge
flange will be created using the top edge of the base flange as the reference. You will
observe that the Sheet-Metal1 feature is displayed in the FeatureManager Design Tree.
First, you need to modify the default bend radius using the Sheet-Metal1 feature before
creating the first edge flange.

1. Select the Sheet-Metal1 feature from the FeatureManager Design Tree and invoke the
shortcut menu. Choose the Edit Definition option from the shortcut menu.

2. Set the value of the Bend Radius spinner to 5 and choose the OK button from the
Sheet-Metal1 PropertyManager.

3. Choose the Edge Flange button from the Sheet Metal toolbar to invoke the
Edge-Flange PropertyManager.

You are prompted to select any of the linear edges of a planar face to create the edge
flange.

4. Select the edges of the base flange as shown in Figure 16-142.

5. Set the value of the Length spinner available in the Flange Length rollout to 300.

Next, you need to edit the profile of the edge flange.

6. Choose the Edit Flange Profile button from the Flange Parameters rollout. If this button
is not available, clear the Use default radius check box and then select it again. The Edit
Flange Profile button will be available. As soon as you choose this button, the sketching
environment is invoked and the Profile Sketch dialog box is displayed.

7. Edit the sketch, refer to Figure 16-143. Choose the Finish button from the Profile Sketch
dialog box. The model after creating the first flange is displayed is Figure 16-144.

Figure 16-141  Base flange Figure 16-142  Edge selected to create edge flange
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Figure 16-143  Modified sketch of edge flange Figure 16-144  Model after creating edge flange

Creating the Second Edge Flange
Next, you need to create the second edge flange.

1. Invoke the Edge-Flange PropertyManager and select the edge as shown in Figure 16-145
to create the edge flange.

2. Set the value of the Length spinner to 100 and edit the profile of the edge flange to
create the holes.

3. Choose the OK button from the Edge-Flange PropertyManager.

The model after creating the edge flange is shown in Figure 16-146.

4. Similarly, create the edge flanges on the left of the sheet metal component. The model
after creating the edge flanges and holes is displayed in Figure 16-147.

Figure 16-145  Edge selected to create edge flange Figure 16-146  Model after creating second edge
flange
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Creating the Tab Feature
Next, you need to add a tab feature to the sheet metal component. Generally, a tab
feature is used to add material to the base flange or any other flange feature.

1. Select the front face of the base flange as the sketching plane and invoke the sketching
environment.

2. Create the sketch as shown in Figure 16-148.

3. Choose the Base-Flange/Tab button from the Sheet Metal toolbar to create the tab feature.
The model after creating the tab feature is displayed in Figure 16-149.

Figure 16-147  Model after creating edge flanges and holes on the left of the model

Figure 16-148  Sketch of the tab feature Figure 16-149  Model after creating the tab feature
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Similarly, create the other edge flanges. The model after creating the other flanges is
displayed in Figure 16-150.

Creating the Hem Feature
After creating the other sheet metal features, you need to create the hem on the right
most edge flange.

1. Choose the Hem button from the Sheet Metal toolbar. The Hem
PropertyManager is displayed.

2. Choose the Closed button from the Type and Size rollout and set the value of the Length
spinner to 10.

3. Select the edge as shown in Figure 16-151. The resultant hem is displayed in Figure 16-152.

Creating the Flat Pattern
After creating the sheet metal component, you need to create the flat pattern of the sheet
metal component.

1. Choose the Flatten button from the Sheet Metal toolbar to create the flat pattern
of the sheet metal component.

2. Orient the flattened model parallel to the screen.

The flatten sheet metal component is displayed in Figure 16-153.

Figure 16-150  Model after creating all the edge flanges
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Figure 16-151  Edge selected to create hem Figure 16-152  Resultant hem created

Figure 16-154 shows the FeatureManager Design Tree of the sheet metal component.

Saving the Model
Next, you need to save the model.

1. Choose the Save button from the Standard toolbar and save the drawing with the
name given below and close the file.

\My Documents\SolidWorks\c16\c16-tut01.SLDPRT.

Figure 16-153  Flatten sheet metal component
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Figure 16-154  FeatureManager Design Tree of sheet metal component

Tutorial 2
In this tutorial, you will create the sheet metal component shown in Figure 16-155. The flat
pattern of the sheet metal component is displayed in Figure 16-156. After creating the model,
you need to generate its drawing views as shown in Figure 16-157. The drawing views and
dimensions are displayed in Figure 16-158.          (Expected time: 1hr)

Figure 16-155  Sheet metal component
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Figure 16-156  Flatten sheet metal component

Figure 16-157  Drawing view of the model
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Figure 16-158  Views and dimension for Tutorial 2

The steps to be followed to complete this tutorial are discussed next.

a. Create the base feature by extruding a sketch created by selecting the Top plane as the
sketching plane, refer to Figure 16-159.

b. Shell the base feature, refer to Figure 16-160.
c. Convert the shelled solid model into sheet metal component, refer to Figure 16-161.
d. Rollback the model to the state where no bends were added to the sheet metal component.
e. Add the flanges to the sheet metal component, refer to Figures 16-162 through 16-164.
f. Create the flat pattern of the sheet metal component, refer to Figure 16-165.
g. Create the slots using the cut feature and pattern it on the sides of the flatten sheet

metal component, refer to Figures 16-166 through 16-168.
h. Unflatten the sheet metal component, refer to Figure 16-169.
i. Generate the drawing views of the sheet metal component, refer to Figures 16-170 through

16-172.

Creating the Base Feature
You will create this model by converting a shelled part into a sheet metal component.
Therefore, you first need to create the base feature of the model. The base feature of the
model is created by extruding a sketch created on the Top plane.

1. Create a new SolidWorks document in the Part mode.
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2. Invoke the sketching environment by selecting the Top plane as the sketching plane.

3. Create the sketch of the base feature that consists of a rectangle of 250x200mm.

4. Extrude the sketch to a distance of 30.

The model base feature of the model is displayed in Figure 16-159.

Shelling the Base Feature
Next, you need to add the shell feature to the model. While adding the shell feature to
the model, you will remove the bottom face of the base feature.

1. Rotate the model so that the bottom face of the model is clearly visible.

2. Invoke the Shell1 PropertyManager and select the bottom face of the base feature as the
face to remove.

3. Set the value of the Thickness spinner to 1 and choose the OK button from the Shell1
PropertyManager.

The model after shelling is displayed in Figure 16-160.

Converting the Shelled Model into Sheet Metal Component
After creating the base feature and shelling the model, you need to convert it into a sheet
metal component. A solid model is converted into sheet metal component using the
Bends PropertyManager.

1. Choose the Insert Bends button from the Sheet Metal toolbar to invoke the Bends
PropertyManager.

2. Select the top face of the model to fix.

Figure 16-159  Base feature Figure 16-160  Model after shelling
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3. Click once in the Edges to Rip area of the Rip Parameters rollout to activate the selection
mode.

4. Select all the inner vertical edges of the base feature as the edges to rip.

5. Set the value of the Bend Radius spinner to 2 and set the value of the K-Factor spinner
to 1.

6. Choose the OK button from the Bends PropertyManager. The SolidWorks warning
message window is displayed. This informs you that auto reliefs are added. Choose the
OK button from this message window.

The model after converting solid shelled model into sheet metal is displayed in
Figure 16-161.

Creating the Edge Flanges
Next, you need to add the edge flanges to the sheet metal component. Before adding the
edge flanges, you need to rollback the model to a stage where there are no bends in the
sheet metal component.

1. Choose the No Bends button from the Sheet Metal toolbar to rollback the model
to the stage where the model is not having any bends. Note that the four walls of
the model are not unbent.

2. Now, select the bottom face of one of the four walls of the model as the sketching plane
and invoke the sketching environment.

3. Create the sketch of the flanges as shown in Figures 16-162.

Figure 16-161  Solid shelled model after converting it into sheet metal
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Figure 16-162  Sketch of the flanges

Figure 16-163  Model after extruding the flanges Figure 16-164  Model rolled to the bending stage

4. Invoke the Extrude PropertyManager and select the Link to thickness check box and
choose the Reverse Direction button.

5. Choose the OK button from the Extrude PropertyManager.

Figure 16-163 shows the model after extruding the flanges.

After extruding the flanges you need to roll the model to the bending stage.

6. Choose the No Bends button from the Sheet Metal toolbar to roll the model to
the bending stage.

The model after rolling to the bending stage is displayed in Figure 16-164.
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Creating the Cuts Across the Bends
The next feature that you need to create is the cut feature across the bends. For creating
this feature, you first need to create the flat pattern of the sheet metal component.

1. Choose the Flatten button from the Sheet Metal toolbar to create the flat pattern
of the sheet metal component.

The flat pattern of the model is displayed in Figure 16-165.

2. Select the top face of the flatten model and invoke the sketching plane.

3. Create the sketch as shown in Figure 16-166.

4. Using the Extruded Cut tool, create the cut feature. The model, after adding the cut
feature, is displayed in Figure 16-167.

5. Pattern the cut feature. The model, after patterning the cut feature, is displayed in
Figure 16-168.

Figure 16-165  Flat pattern of the model Figure 16-166  Sketch of the cut feature

Figure 16-167  Model after adding the cut feature Figure 16-168  After patterning the cut feature
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Unflattening the Sheet Metal Part
After creating the sheet metal component, you need to unflatten the sheet.

1. Choose the Flatten button from the Sheet Metal toolbar to unflatten the sheet
metal component.

The unflattened sheet metal component is displayed in Figure 16-169.

Creating the Flat Pattern Configuration
1. Invoke the ConfigurationManager and add a new configuration with the name Flat

Pattern.

2. Choose the Flattened button to create flat pattern in this configuratioin.

3. Double-click on the Default configuration to make it current.

4. Invoke the FeatureManager Design Tree.

Saving the Model
To complete this tutorial, you need to generate the drawing views of the model. Before
generating the drawing views, you need to save this model.

1. Choose the Save button from the Standard toolbar and save the drawing with the
name given below and close the file.

\My Documents\SolidWorks\c16\c16-tut02.SLDPRT.

Figure 16-169  Unflattened sheet metal component
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Generating the Drawing Views of the Sheet Metal Component
Next, you need to generate the drawing views of the sheet metal component. You will
generate the drawing views in an A4 size drawing sheet with third angle projection as the
standard of the sheet format.

1. Create a new SolidWorks document in the Drawing mode with the A4 as the standard
sheet size. The default projection type is in the first angle. Therefore, you need to change
it to the third angle while defining the paper size in the Sheet Setup dialog box.

3. Generate the default three standard views of the model. Figure 16-170 shows the drawing
sheet after generating the three standard views.

After generating the standard three views, you need to generate the drawing view of the
flat pattern.

4. Generate a drawing view using the Named View tool. Place the view on the right of the
top view.

5. Now, double-click on the Flat Pattern option from the View Orientation rollout. Select
Flat Pattern from the drop-down list available in the Reference Configuration rollout
and choose the OK button from the Named View PropertyManager.

Figure 16-171 shows the drawing sheet after generating the drawing view of the flat
pattern.

Figure 16-170  Drawing sheet after generating the three standard views

c16-solidworks-2003.p65 7/23/2003, 12:19 PM75



16-76                           SolidWorks for Designers
©

 C
A

D
C

IM
 T

ec
hn

ol
og

ie
s,

 U
S

A
. 

Fo
r 

en
gi

ne
er

in
g 

se
rv

ic
es

, 
co

nt
ac

t 
sa

le
s@

ca
dc

im
.c

om

Figure 16-171  Drawing sheet after generating the flat pattern view

Next you need to generate the isometric view.

6. Generate an isometric view and place the view close to the top right of the drawing sheet.
Change the scale of the isometric view to 1:3 using the Custom Scale rollout.

The drawing sheet, after generating all the drawing views, is displayed in Figure 16-172.

7. Save the drawing file.

Figure 16-172  Final drawing sheet
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SELF-EVALUATION TEST
Answer the following questions and then compare your answers with the answers given at
the end of this chapter.

1. In SolidWorks, the __________ button available in the Sheet Metal toolbar is used to
create the base flange.

2. The __________ option available in the Bend Allowance Type drop-down list is used to
specify the bending allowance using the bend tables.

3. Select the __________ option from the View Orientation rollout to generate the drawing
view of the flat pattern of the sheet metal component.

4. The __________ button available in the Sheet Metal toolbar is provided to create hems.

5. The __________ rollout is used to define the bend allowance other than the default bend
allowance that you have defined while creating the base flange.

6. If you need to create the flat pattern of a sheet metal component which is created by
converting if from the part, then choose the Flattened button from the Sheet Metal
toolbar. (T/F)

7. If you create a part with sharp edges and convert it into a sheet metal component, then
the bends added to the sheet metal component are recognized as round bends. (T/F)

8. For creating a closed corner, choose the Closed Corner button from the Features toolbar.
(T/F)

9. The Gap distance option available in the Miter Parameters rollout is used to define the
rip distance between two consecutive flanges. (T/F)

10. The Sketched Bend tool is used to create a bend using a sketch as the bending line. (T/F)

REVIEW QUESTIONS
Answer the following questions:

1. The __________ option available in the Bend Allowance Type drop-down list is used to
define the K-Factor.

2. The __________ tool is used to create a series of flanges along the edges of the sheet
metal component.

3. The __________ check box is used to set the value of the feature termination according to
the thickness of the sheet.
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4. The distance value of the rip is modified using the __________ spinner while creating the
miter flange.

5. To create lofted bends, choose the __________ button from the Sheet Metal toolbar.

6. Which button available in the Sheet Metal toolbar is used to fold the unfolded sheet?

(a) Flattened (b) Fold

(c) Bends (c) Unfold

7. Which tool is used to rollback the sheet metal component to the stage where it was not
having any bends?

(a) Flattened (b) No Bends

(c) Unfold (d) Remove Bends

8. To unfold the sheet, you need to invoke the __________ tool?

(a) Unfold (b) Flattened

(c) No Bends (d) None of these

9. Which tool is used to create the sketch that will be used as bending lines?

(a) Centerline (b) Arc

(c) Spline (d) Line

10. Lofted bends are creating between

(a) two sections (b) three sections

(c) a section and an edge (d) None of these

EXERCISE

Exercise 1
In this exercise, you will create the sheet metal component shown in Figure 16-173. The flat
pattern of this model is displayed in Figure 16-174. This model is created by first creating a
base flange. After that, you will create a miter flange to complete the sheet metal component.
The default bend radius is 2mm, K-Factor is 0.5, Relief is rectangular with ratio 0.5. Thickness
of the sheet is 1mm. Rip gap for miter flange is 2mm. Views and dimensions for this model
are shown in Figure 16-75.    (Expected time: 15 min.)
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Figure 16-173  Sheet metal component

Figure 16-174  Flat pattern of the sheet metal component
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Figure 16-175  Views and dimensions for Exercise 1

Answer to Self-Evaluation Test
1. Base-Flange/Tab, 2. Bend Table, 3. Flat Pattern, 4. Hem, 5. Custom Bend Allowance, 6.
T, 7. F, 8. F, 9. T, 10. T  
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